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Terminology Used in This Tutorial
Context-sensitive menu This menu is accessed by clicking the secondary mouse button (the right

button if your mouse is configured for right-handed use) in a window within
VersaPro. If your mouse is configured for left-handed use, click the left
button where the instructions say “right click.” The context determines
which options are presented on the menu.

Menu selections For commands that are selected from a menu, the following sequence is
given: the menu name, submenu (if any), command. For example, to display
the Expanded Function Toolbar, select View, Function Toolbars, Expanded.
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Lesson 1: Installation
VersaPro will run on Windows 95, Windows 98, Windows 2000, and Windows NT (with Service Pack 3 or
greater).  Installation is a straightforward operation:

• Insert the CD into your CD drive, then find and double click on the setup.exe file.

If you are using Windows 95 and you do not have Dcom 95 installed on your computer, you will be prompted
to install it.  After Dcom is installed, you must restart your computer before you continue with the installation.

Lesson 2: Starting VersaPro and Creating a Folder
1. To start the program, select Start, Programs, GE Fanuc Software, VersaPro, VersaPro (or use shortcut keys

CTRL+ALT+V). The VersaPro workbench will appear.

2. Maximize the VersaPro workbench to fill the entire screen.  To create a folder, select File, New Folder. The
New Folder Wizard will appear.

3. Enter Lab_1 for the Folder Name and a description in the Folder Description field if desired.  If you want to
put the new folder in a directory different from that specified in the Location field, click the browse button
next to the Location field.
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4. Click the Next button. The following screen will appear. Note that the default selection is Empty Folder.

5. Click the Finish button. The VersaPro workspace will appear.
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Lesson 3: Customizing the Workspace
The VersaPro workspace is customizable, and the options are saved on a user basis – that means that the
settings you save on your PC will be retained for you.  The first time you start VersaPro, you will see a default
workspace configuration that is very basic. Your task in this lesson is to modify the default workspace so that it
looks similar to the following figure:

Ladder Editor

Variable Declaration Table

Folder
Browser

Function Toolbar,
compact view

VersaPro Workspace
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Display and place the toolbars and tables.

This lesson uses the Lab_1 folder that you created in Lesson 2.  (To open a folder, select File, Open Folder.)

1. Display the toolbars by choosing View, Toolbars. In the View Toolbars dialog box, select all of the toolbars.
Click Apply, then OK.

Standard Toolbar

Ladder Toolbar

90-70 Ladder

View Toolbar

Folder Toolbar

PLC Toolbar

2. Click and drag the toolbars to positions to match the Workspace shown on page 5.

Note: The Folder Browser, Variable Declaration Table, expanded Function Toolbar, and Local Logic
Variable Table (used in Motion programs) can be docked (fixed) or undocked (floating). These
windows are docked by default. To select or deselect docking, click the secondary mouse button in the
window and choose Allow Docking from the context-sensitive menu. Windows should be undocked
only temporarily for moving and then redocked.

3. Display the compact Function Toolbar by selecting View, Function Toolbars, Compact.

Function Toolbar, Compact
4. If they do not already appear, display the Folder Browser and Variable Declaration Table by clicking their

buttons in the View toolbar.

5. Undock the Folder Browser and click and drag it to the position shown in the VersaPro Workspace figure on
page 5. Repeat this procedure with the Variable Declaration Table and the Function Toolbar.
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Adjust the ladder diagram options.

1. Open the Options Dialog box by selecting Tools, Options.

2. Select the Ladder tab and check Variable Name in the Show/hide field box.  Next, click the Full button.
This causes the Variable Names to be displayed in full mode (up to 2 lines, up to 32 characters).

3. Check Reference Address. (Brief is the only mode available.)

4. Check Description in the Show/hide field box, and click the Full button again.   The Variable Descriptions
will now be displayed in full mode (up to 4 lines, up to 64 characters).

5. Adjust the Grid Cell Width slide bar until you are comfortable with the Grid Cell Width.  Notice that the cell
width in the LD editor changes as the slide bar is adjusted.

6. For the purposes of this lab, make sure the Coil/Jump Justification Column checkbox is not selected.  If this
box is not checked, coils are inserted in the next empty column. If this box is checked, coils are placed in the
column specified (right justified). Valid values are integers 10 to 20. (For 90-70 PLCs, Coil/Jump
Justification Column should be selected and the value should be 10.)

7. Leave the Show 8x10 Rung Indicator selected. This causes a border to be displayed on the outside edge of
row 8 and column 10. (For 90-70 PLCs, this option is always selected.)

8. Click OK. Review the Ladder Editor window to see the effects of the changes you made.
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Adjust the display options.

1. Open the Options Dialog box by selecting Tools, Options.

2. Select the Display Tab and click LD in the Category box.  Next, pick Background in the Colors box and
choose an appropriate color.

3. Use the Font list box to select a different font.

4. Click OK.

Note: For additional information on setting VersaPro options, refer to the User's Manual or to online Help.

Build a simple ladder diagram.

Enter the following simple rung in the Ladder Diagram editor by selecting each ladder component from the tool
bar and placing it in the Editor window.  To enter the contact variable, select the normal pointer (press escape),
double click above the contact, and choose T_100MS from the list box. To enter the coil reference address,
double click the coil and type 1q.

T_100MS %Q00001

Edit a variable name.

In the Variable Declaration Table, type in a name and description for %Q00001.  The name may be up to 32
characters in length, and the description may contain up to 64 characters.

The workspace on your desktop should now be similar to the one pictured on page 5.
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Lesson 4: Importing Files
One of the first tasks you might undertake is to import a program developed using one of GE Fanuc’s earlier
PLC programmer products, Logicmaster or Control.  (VersaPro also provides the ability to import variables
created in other applications such as CIMPLICITY HMI, Logicmaster, Control, or tools like Excel or Access.)
To accomplish the tasks in this lesson, you will need syntactically correct Control and Logicmaster folders and
Excel.  The tasks are independent of each other – if you skip one, you will still be able to do the others.

Import a Logicmaster folder.

Series 90-70, Series 90-30, and Series 90 Micro folders can be imported from Logicmaster.

1. Select File, New Folder.

2. You will be prompted to close and save your existing open folder.  (Only one folder can be open at a time.)
Click Yes.

3. The New Folder Wizard will appear. Type a name of your choice for the folder.  If you want to put the new
folder in a directory different from that specified in the Location field, click the browse button next to the
Location field to select the folder path.

4. Click the Next button.

5. On the next screen, choose Import Logicmaster 90.  In the From field, use the browse button to locate a
Logicmaster folder.

6. Click Finish. The New Folder Wizard closes, and VersaPro attempts to complete the import process. Details
of the import process are logged in the Information Window.

7. Spend a few minutes reviewing this folder.  Note that all nicknames are imported and that all comments
retain their original format.  See how different instructions look in the VersaPro ladder diagram editor.  You
can use the function toolbar to create new logic.
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Import a Control software folder.

You can import VersaMax (.F2K), Series 90-30 (.F3X), and Series 90-70 (.EF7) folders from Control.

Note: When importing a Control folder, variables must first be exported from the Control folder in shared
name file (SNF) format, if you want to import the variables.

1. Create an SNF File.

a. If you do not already have an .snf file containing variable information, open a folder in Control
software and use the Export feature from the Variable Declaration Table to create an .snf file.

b. Close Control before you proceed.

2. Create a new folder in VersaPro.

a. Select File, New Folder.

b. You will be prompted to close your existing open folder. (Only one folder can be open at a time.)

c. The New Folder Wizard will appear. Create a new folder with a new name. If you want to put the
new folder in a directory different from that specified in the Location field, click the browse
button next to the Location field to select the folder path.

d. Click the Next button.

e. Choose Import Control on the next screen. In the From field, use the browser button to locate a
Control folder.

f. Select the Include SNF checkbox, then click the Browse button and, in the Browse dialog box that
appears, locate the SNF file that is associated with the Control file to be imported. (This field is
optional.)

g. Click OK to begin the Import process.

h. Spend a few minutes reviewing this folder.  Note that all nicknames are imported.  Also, note that
Comment contents are not imported.  See how different instructions look in the VersaPro ladder
diagram editor.  You can use the function toolbar to create new logic.

3. Import a Shared Name File.

a. In the folder you just created, select any cell in the Variable Declaration Table. Select Tools,
Import Variables.

b. Locate the Shared Name File (filename extension .snf) on your computer. A browser window will
open.

c. Click Open to import the file. If the file being imported contains variables that conflict (same
name and scope) with those in the VersaPro folder, the Variable Resolution dialog box will
appear. If this happens, you can simply click OK to accept the default settings, or press F1 to get
more information about the Variable Resolution settings.

d. The results of the Import process will be logged in the Information Window. Verify that the
variables you imported appear in the Variable Declaration Table.
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Use Excel to create variables.

You can use a spreadsheet program, such as Excel, to conveniently edit large numbers of variables. You can
easily manipulate variables and then copy and paste them to the Variable Declaration Table.  If you have Excel
on your computer, try the following:

1. Go to the All tab in the Variable Declaration Table (VDT).

2. Select all the variables and copy them.

CAUTION: Deleting the variables will also delete the addressing defined in logic.  You should never
delete entries in the VDT unless you are sure the address is not being used.  Never delete all
of the variables in an actual application folder.

3. In the VDT, create a variable that can be easily indexed in Excel using the auto-increment feature –
something with a number at the end like Tank_1.

4. Select the entire variable row, and use either Copy/Paste or Drag and Drop to move this to Excel.

5. Replicate about 100 or so of these variables in Excel. Remember, only the variable name and reference
address values should increment.  If you have questions about how to do this, refer to the Excel
documentation.

6. Select all the variables you created in Excel, and copy them.

7. Go to the first blank line in the VDT and paste the variables into the table.

8. The first thing you should note is that you are prompted to correct a discrepancy between the first variable in
the Excel file and the variable you created in VersaPro.  VersaPro will prompt you to correct errors as you
go allowing you to complete the import even if there are conflicts.  Correct this by renaming the variable,
and complete the import.
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Lesson 5: Using Hardware Configuration
The Stand Alone Hardware Configuration (HWC) features a Parameter Editor window that allows you to
configure module parameters in either a tabbed or spreadsheet view. HWC supports Series 90-30, Series 90-70,
VersaMax modular, VersaMax Nano/Micro, and Series 90 Micro rack systems.

Become familiar with the Standalone Hardware Configuration tool.

1. Create a new folder and name it Lab_2.

2. Start HWC by double clicking Hardware Configuration in the Folder Browser or clicking the Open

Hardware Configuration button in the View toolbar.  You will see a screen similar to the one shown
below.

Rack View

Log View

Power
Consumption
View

Reference
View

Status Bar

3. The Log View, Power Consumption, and Reference View windows are dockable (they can be set to a fixed
location in the Workspace).  Move the windows to a position you are comfortable with.

Note: Docking is selected by default. To turn docking on or off, select Allow Docking from the context-
sensitive menu.

4. Toggle the Reference View , Log View , and Power Consumption View  windows off and on
by clicking the buttons on the toolbar.
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Change the hardware configuration type.

If the Default Hardware Configuration rack (VersaMax by default) is not the type you plan to work with, it can
be changed using the following steps:

1. In the HWC window, choose File, Convert To.  From the Convert To submenu, select Series 90-30, Series
90-70, VersaMax Nano/Micro, or Series 90 Micro. The current system type will be grayed out.

2. Note that when you change the hardware type, the module configurations associated with the previous type
will be lost.

3. Change the system back to VersaMax by selecting File, Convert To, VersaMax.

Note: The Default Hardware Configuration setting in VersaPro's Options dialog box determines the default
PLC type for a new folder. (The initial setting is VersaMax.) To change the Default Hardware
Configuration setting, go to the VersaPro window and select Tools, Options. On the General tab,
change the Default Hardware Configuration to the type that you will be using. The next new folder that
you create will use the new default hardware setting.

Create a basic configuration.

Note: This exercise is based on VersaMax hardware. The same general procedures are used to create other
rack systems.

1. Right click on the Power Supply Module and choose Replace Module.

2. Choose a Power Supply from the Module Catalog and click OK.  Review the information in the Parameters
Dialog Box and click OK.

3. Right click on the Power Supply Module and choose Replace CPU.

4. Choose a CPU from the Module catalog and click OK. A Parameter Editor window, similar to the one
below, will appear.

5. Click the window close button  to close the Parameter Editor window.

Note: VersaMax is the only PLC type that uses Carrier/Base modules. If you are configuring a different type,
skip steps 6 through 8.

6. Right click again on the Power Supply Module and choose Add Carrier/Base from the context-sensitive
menu.

7. Choose a base from the I/O Carriers or the Communications Carriers tab and click OK.
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8. Right click on the Carrier you just added, and choose Add Module.  Select a module and click OK. (The
appropriate Module Catalog for the Carrier will be displayed.) Close the Parameter Editor window. Your
rack system configuration should be similar to the following figure.

Basic VersaMax Rack System

Familiarize yourself with the Parameter Editor.

1. Right click on any module in the rack system and choose Configure CPU Parameters. The Parameter Editor
window for the CPU will open.

2. Experiment with the following Parameter Editor features:

• Tooltips: When you pass the cursor over an editable cell, valid choices will be displayed in a tool tip.

• Inline Editing: To place a value directly into a cell, click the cell and start typing.

• Data Entry Tool: To open the Data Entry Tool, double click or right click on the selected cell, or press F2.
The Data Entry Tool provides editing controls appropriate to the type of data being entered in the selected
cell. For Reference Address and Range values, its built-in limit values and available reference value ranges
prevent you from using the spin buttons or slider bar to enter values outside the allowable limits. However,
you can override these limits by typing in any desired value.

• Error Color: Erroneous or unavailable values are highlighted in the Error Color (default color is red). To
change the Error Color, select the HWC Tools menu, Options. Choose Text Error from the Colors list.

• Mode Setter Parameters: These parameters affect other parameters and are listed in italics. The value
entered for a Mode Setter can alter the format and content of the Parameter Editor window. For example,
fields may be added or removed from individual tabs, and/or entire tabs can be removed or replaced.
Changing a Mode Setter can also erase parameter information that you might already have entered. It is
strongly recommended that you select Mode Setter values before entering data for the other parameters in
the dialog.

To see examples of Mode Setters, look at Sweep Mode on the CPU Scan tab and Port Mode on either of the
Port tabs. For an explanation of parameter relationships for these parameters, select the parameter and
choose What's This from the context-sensitive menu.

• Module Help: For a summary of each parameter on the tab being displayed, choose Help, Module Help.
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• Spreadsheet Mode: Spreadsheet mode allows all parameter groups to be displayed and edited in a single,
scrollable view. (Default is tabbed mode.) To change the edit mode, select View, Parameter Edit. You can
also select Tools, Options, and then select the Parameter Edit Options tab. The following figure shows the
editor window for the VersaMax CPU002 in spreadsheet mode.

3. Close the Parameter Editor window.

4. Note that the rack system Status Bar indicates "Not Saved." To save your configuration, click the Save

button  on the toolbar, or select File, Save.

Convert the Hardware Configuration.
If you do not have a VersaMax PLC, you will need to convert the HWC to the PLC rack system that you will be
using to be ready for Lesson 6.

1. In the HWC, select File menu, Convert To.

2. Choose the PLC rack system from the Convert To submenu. A dialog box will appear informing you that
converting to a different rack system will cause all modules to be deleted from the current configuration.

3. Click Yes to continue. The default configuration for the rack system you selected will appear. Configure the
rack system to match that of your PLC.

4. Save and Close the Hardware Configuration.
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Lesson 6: Creating a Ladder Logic Program
Lessons 6 through 10 use the Lab_2 folder that you created in Lesson 5. If it is not already open, select File,
Lab_2.

The ladder editor in VersaPro is a free form editor that allows you to place elements in different rungs, assign
names and addresses when convenient, and then check and compile the program all at once or block-by-block.
The editor also includes common Windows features such as undo, copy/paste, and drag and drop.

Place, name, and assign addresses to Boolean elements in the ladder
diagram.

1. Make sure that the VDT is visible. If not, select View, Variable Declaration Table, or press Alt + 3.

2. If the MAIN.blk Ladder Diagram editor window is not open, double click the _MAIN-LD block in the
folder browser.

3. In the VersaPro _MAIN.blk window, click the Normally Open Contact button  on the Ladder Toolbar.

4. Move your cursor into the ladder diagram.  Note that the mouse pointer has a Normally Open Contact
symbol as a subscript.  Click in the first row and leftmost column in the ladder diagram. A Normally Open
Contact is placed in the grid where the pointer sits, and a gray box surrounds the contact.

5. Without moving the cursor, type Input_1, 1i and press Enter.  The editor recognizes that you are typing a
variable name and address, shows the name in the ladder diagram, and places the name and address in the
VDT. (1i indicates the address %I00001.)

6. Note that the Normally Open Contact button “sticks.”  Once it is selected, you will place a contact in every
time you click in the diagram.  Cancel the Normally Open Contact selection by pressing the Escape key.

7. Click the cursor to the right of the Input_1 contact and type nocon (for Normally Open Contact).  Since
there is no element in the current space, a progressive search is performed to find the element you want as
you type.  Press Enter.

Note: You can drag and drop a variable from the VDT to an element in the logic editor if the function does
not have a variable assigned to the parameter.  Steps 8 and 9 use this alternate means of assigning a variable
name to an element.

8. In the VDT, type the Name, Type, Len, and Address as shown in the figure below. (You can type in the
bottom, empty row or choose Insert Row from the context-sensitive menu.)

9. Select the name Input_2 and drag it to the contact that you created in step 7.

10. Choose the Normally Open Coil  from the Ladder Toolbar.

11. Place the coil in the diagram a few spaces away and to the right of the second contact.

12. Type Output_1, 1q and press Enter. A variable named Output_1 with a reference address of %Q00001 will
be created in the VDT. Press Escape.

13. Use point-to-point wiring to connect the contacts and the coil.  Do this by placing the pointer on the right
side of the second contact, then right click, hold, and drag to draw a connection from the contact to the right
side of the coil. (The cursor changes to a hand with a pencil.)
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Your rung should look like the following figure.

First Rung

Place a function block in the ladder diagram.

1. Choose Data Move from the box on the left side of the Compact Function Toolbar.  The listbox will become
populated with the Data Move Functions.

2. Choose MOVE_WORD from the listbox, click the Function Drop Mode button , and move the cursor
into the ladder diagram. A small function block icon will appear next to the mouse pointer.

3. Place the MOVE_WORD instruction in the diagram underneath the rung you created earlier by clicking in
this location.  Notice that this automatically becomes Rung 2 in the margin. Press the Escape key.

4. Wire the power flow input of the function to the power rail using the point-to-point wiring method.

5. Click in the grid block next to the IN input on the MOVE_WORD function.  A gray box will appear next to
the input.

6. Type 16#A01 and press Enter.  You have just entered a hexadecimal constant as input to the function. The
same convention is followed for octal and binary numbers (8#, 2#).  You do not need to type a 0 in as a
placeholder.

7. After hitting Enter, the gray box moved over to the space next to the Q output.  Type REG_1,1R and press
the Enter key. The name and address are added to the VDT.

8. Next, double click on the function block.  The Function Properties Dialog Box appears.  Enter the desired
length (and for other functions, the address) and click OK.

Insert a row and drag & drop.

1. Insert an empty row between the Rungs 1 and 2 by right clicking on the MOVE_WORD function and
selecting Insert Row from the context-sensitive menu.
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2. Highlight the function block by clicking on the space to the left of the block and dragging down and to the
right.  Make sure the entire block and connected values are highlighted, including the constant 16#A01 and
the output Reg_1.  Release the mouse button.

3. Place the pointer back in the highlighted area and click and drag.  When the function block is in the desired
position, release the mouse button.  The entire block has been cut and pasted into the new location.

4. Note that similar results can be achieved by highlighting an area and then right clicking and choosing Cut
and then moving the cursor to the new location, right clicking, and selecting Paste. Or, you can use Ctrl + C
and Ctrl + V to cut and paste the highlighted elements.

5. Save your work: Select File, Save All or press Ctrl + Shift + A.

Insert a comment.

1. Click in an area below Rung 2.

2. From the Insert menu, select Comment. A comment line will appear in the area where the cursor was.  This
is automatically named Rung 3.

3. Double click on the comment line.  A scroll box will appear.

4. Type in your comment, hitting enter when you want to create a new line.  When you want to exit, press Ctrl
+ Enter to leave the comment window. Your LD program should be similar to the one shown below.

Note: To change the comment display format, select Tools, Options and choose the Brief or Full option on
the General tab.
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Compile the program and navigate to errors

1. Insert a few contacts without naming them and a few function blocks without assigning lengths or inputs or
outputs

2. Select Folder, Check Block _MAIN.  This compiles the folder and brings up the Information Window.  If
the Information Window is too small, place the cursor on the edge of the window and click and drag to
enlarge it.

3. Scroll through the Information Window to see the errors.  To navigate to an error, place the cursor on the
error text and double click.  The area where the error occurred will be highlighted in the Ladder Editor
window.

4. Fix the errors and check the block again.  When there are no more errors, the Syntax Check Summary in the
Information Window will show “Total errors: 0.”

Lesson 7: Creating New Blocks
You can create new objects in the folder by right clicking in the Folder Browser and picking the appropriate
menu item from the File menu or the context-sensitive menu.

Note: If you are using a Series 90 Micro PLC or Series 90-70 PLC, which do not support Instruction List
subroutines, you will want to skip Lessons 7 and 8. You can continue with lessons 9 and 10.

Create an Instruction List block.

1. Right click in the Folder Browser and select New, Subroutine, Instruction List from the context sensitive
menu.  The Create New Instruction List dialog box will be displayed.

2. Name the new block and type in a brief description of the block.  Click OK. An Instruction List editor
window for the new block will open.

3. Set temporary variables for the IL block. Select Edit, Properties, Variable Table. Select the Temporary
Variables radio button. In the Boolean Address Start field, type 1T (or %T00001). In the Integer Address
Start field, type 500R (or %R00500). Click OK.

Place a call to your new block in the _MAIN program.

1. Open the _MAIN program. (If the _MAIN program is already open, select it from the Window menu. If it is
not open, double click the _MAIN-LD block in the folder browser.)

2. Click the Call  button in the Ladder Toolbar and then click in the ladder diagram below the comment
you created in Lesson 6. Press Enter. The Call function block will appear as follows.

3. Press Enter and select the new block from the list box that appears.
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Lesson 8: Instruction List Editor

Create Instruction List Logic
Select the IL block that you created in Lesson 7.

1. In the first row of the IL editor, double click in the Instruction column. A list box containing instructions
will appear.

2. Type move_word. (The list box will perform a progressive search.) Select the MOVE_WORD( instruction
and press Enter. The parameters for this instruction will automatically appear, and the cursor will move to
the cell in the Operand column for the first parameter.

3. For the IN parameter, in the Operand column, type REG_1 (or select REG_1, G from the drop down list)
and press Enter. Since the variable REG_1 has already been defined, %R00001 will appear in the Ref.
Address Column.

4. For the Length parameter, type 3 and press Enter.

5. For the Q= parameter, type REG_2 and press Enter. Since this is a new variable, the Ref Address cell for it
will remain empty. Note that Reg1 appears in the VDT.

6. In the VDT, type 200R in the Address cell for Reg1 and press Enter. In the IL Editor, %R00100 will appear
in the Ref Address column for Reg1. Your IL program should resemble the following figure.

7. Save your work: Select File, Save All or press Ctrl + Shift + A.
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Lesson 9: Connect to a PLC, Store a Folder, and Monitor
This lesson uses the Lab_2 folder that you created in Lessons 5 through 8.

Communications Setup

Note: If you have already created a Device configuration for your PLC using the Communications
Configuration Utility (CCU), you can skip this step. (A Device configuration in the CCU consists of a
name that you provide for the configuration, the PLC model, and the default port that VersaPro will
use to communicate to the PLC.)

1. Select Tools, Communications Setup.  (If a password has been defined for the CCU, the Password dialog
box will appear. Enter the password and click OK to continue.)  The main screen of the CCU will appear.

2. On the Devices tab in the CCU, click the New button.

3. In the Add New Device dialog box, provide a Name for the PLC device that you will be connecting to. As a
minimum, you need to select a Default Port under Selected Device Parameter Settings.

4. When you have finished setting up communications for your PLC, click OK to close the CCU and save
changes.

Connect, Store and Run

1. Make sure the logic in your folder is syntactically correct. (To check the logic in all the blocks, select
Folder, Check All.)

2. Click the Connect button on the PLC toolbar. 

3. When the Connect dialog box appears, choose the Device and press the Connect button.  Once the PLC is
connected, the buttons on the PLC Toolbar will be enabled.

4. Once the Connect operation is complete, look at the status bar in the bottom right section of the VersaPro
window.  The status bar will show you the Mode (Run, Stop, etc.), Connection Status, Sweep Time (if
running), and whether the folder in the PLC is Equal to the current folder in VersaPro. (Since you have not
yet stored your program, the folder will be Not Equal.)

Mode

Connection
Status

Sweep Time
Equality
Status

VersaPro Status Bar

5. If there are faults noted in the status bar, open the Fault Table by selecting Tools, Fault Table. Clear the
table by pressing F9 and then close the table.

6. Put the PLC in STOP mode: Click the Stop PLC button  or select PLC, Stop.
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7. Click the Store to PLC button on the PLC toolbar.   The Store Folder to PLC dialog box will appear.

8. Make sure Store Logic to PLC is selected and click OK.

9. Review the results in the Information Window. If the store completes successfully, everything is fine. If you
had errors compiling your program, review the log, double-click on the errors, correct the errors and repeat
the store operation. (Double clicking the error takes you to the error in the Logic Editor window.)

10. Once Store is complete, put the PLC in run mode by clicking the Run PLC button.

Note: To hide the Log view, choose Hide from the context-sensitive menu.

Monitor the PLC

1. Select View, Monitor, Active Window.  You should see Real Time Updates in your Ladder Diagram.

Note: You may see the message, "Update in Progress or Unavailable – F1 for Help" in the title area of the
selected window. This message appears briefly while waiting for real-time updates from the PLC.

2. Toggle a value by selecting on a Ladder Element and then clicking the Toggle a Reference button  on
the PLC toolbar. The toggled element will be highlighted in red.
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Lesson 10: View Tables

Create a Variable View Table

Variable View Tables (VVTs) allow you to monitor the states of variables when the folder is online and equal
with the PLC. With VersaPro connected to the PLC and with the program you created in Lessons 6 through 8
running, complete the following steps:

1. Select File, New, View Table, Variable View Table.

2. The New Variable View Table dialog box will appear.  Name the table and click OK.  The VVT will appear.

3. Place a variable in the table by typing in a variable name (such as INPUT_1).  As you type the name, a
progressive search will be performed to help you find the variable you’re looking for.

4. You can place variables by copying and pasting them from the VDT or the Ladder diagram. You can also
drag them from the VDT.  Place INPUT_1 and another instance of REG_1 into the Variable View table
using one of these techniques.

5. To display a value in a different numerical format, select the value, then choose Display Format from the
View menu or the context-sensitive menu. In the figure below, the second instance of REG_1 is displayed in
hexadecimal.
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Create a Reference View Table

Reference View Tables contain a list of references that can be monitored and updated when the folder is online
with the PLC. A Reference View Table displays data when the folder is open and online, and "Monitor All" or
"Monitor Active" is selected and the RVT is active.

All reference addresses are displayed that begin with the closest byte offset smaller than or equal to the starting
address you enter.

1. Right click in the folder browser and select New, View Table, Reference View Table from the context-
sensitive menu. Name the table and click OK.  The new table will appear.

2. Insert a row of variables by typing an address in the Address column (this is the starting address for the
row).  Any type of address may be entered. (You can also copy and paste an address from the VDT)

3. As in the VVT, you can change the display format of a selected value. To display a value in a different
numerical format, select the value, then choose Display Format from the View menu or the context-sensitive
menu.

Lesson 11: Reports and Printouts
You can print folder documentation in the background while you continue work. Reports and printouts can only
be generated for the folder that is open.

Create a custom footer for your reports and printouts.

Custom header and footer information is created by entering text strings in the Folder Properties dialog box.
You can include format switches in the text string to control the appearance of the custom text.

This text appears in addition to the standard VersaPro header and footer.

1. Select Edit, Properties, and Folder. The Folder Properties dialog box appears.

2. In the Footer field, type the following string (replace the text in italics with the appropriate information):

^VersaPro Tutorial%nYour Initials>Company Name

The footer will appear as follows when the report or printout is printed:

VersaPro Tutorial
your initials                                                                          your company name

<<<Standard VersaPro footer>>>
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Custom Header/Footer Format Switches

Switch Name Result

%n new line Place the following text on a new line.

> arrow Right justify the following text. (Text is left justified by default.)

^ carat Center the following text.

>> double arrow Print an arrow: >.

^^ double carat Print a carat: ^.

The > and ^ format switches affect all the text that follows them until the end of the string or until
the next ^, >, or %n.

Print a report.

1. Select File, Print Report.

2. In the Print Report dialog box, select the options that you want to print. (For more information, click the
Help button.)

3. When you are ready to print, click OK.

Conclusion
You are now familiar with the basic functionality in VersaPro.  Some features have not been discussed, but
everything needed to successfully start programming and running PLCs with VersaPro 2.0 has been introduced
in this tutorial. We encourage you to further explore the capabilities of VersaPro 2.0 using the online Help and
the VersaPro Programming Software User's Guide, GFK-1670.

Remember that GE Fanuc Automation is constantly striving to improve the productivity of our customers, and
we would like to hear any feedback you have.  If you have suggestions for improvement on this product, please
contact your GE Fanuc representative.
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